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Rosemarie Bartlett: Welcome, ladies and gentlemen. I'm Rosemarie Bartlett with the Pacific 

Northwest National Laboratory, and I'd like to welcome you to today's webcast, 

REScheck Basics brought you to by the U.S. Department of Energy's Building 

Energy Codes Program. 

 

 At this time, all participants are in a listen-only mode.  Before we begin the 

webcast, we will conduct a polling session.  We have one polling question for you 

today.  To answer the question, you will need to press the numbers on your 

touchtone phone.  Please wait for the entire question to be read before 

responding. There will be a brief 10 to 15 second period of silence after the 

question has been asked so that the results can be compiled.  Please remain on 

the line.  

 

 The question is: How many attendees are at your location viewing the webcast 

together?  Please use the appropriate number on your phone to represent the 

number of viewers at your site.  For example, press one for one viewer, two for 

two viewers, and so on.  Please press nine to represent nine or more viewers.  

Once again, the question is:  How many attendees are at your location viewing 

the webcast together?  Please use the appropriate number on your phone to 

represent the number of viewers at your site. Please answer now by using your 

touchtone phone.  Please remain on the line during the silence while the results 

are compiled.  Thank you, this concludes the polling session.   
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 A couple of logistical announcements before we begin. You may ask a question 

at any time during the webcast today by using the question pane on your 

computer.  Questions won't be answered via the computer but will be answered 

live by the presenters as time allows at the end of the presentation.  For those of 

you wanting Continuing Education Credit for the event today, a link will be 

provided at the end of the webcast.  AIA members should write down the link and 

go to that link and provide us with their names and AIA membership numbers, 

and we will submit the information to AIA for their credit.  In addition, anyone 

wanting a Certificate of Completion to self-report to a professional organization, 

should write down the link to go generate and print one.   

 

 Pam Cole and I will be presenting today.  I'm going to begin with a short 

presentation on the basics of using REScheck, then Pam will provide the 

software demonstration. At the end of the software demonstration, we'll address 

any questions that have come in. 

 

 Since this course is entitled "REScheck Basics," I thought I'd start with the real 

basics about where you can access REScheck.  You access REScheck through 

the Building Energy Codes Program website at energycodes.gov. In the middle 

part of the screen, there's a section about free software and technical support.  

You can access the three REScheck tools from this area of the website.  

REScheck, REScheck-Web, and REScheck Package Generator.  REScheck was 

originally developed to simplify and clarify the Model Energy Code in the early 

'90s, and many years ago it was called MECcheck.  As time has passed, we've 

changed the name to REScheck and also added compliance for the international 

energy conservation code editions.  

 



   
REScheck Basics 

3 

 There are three REScheck tools, as I mentioned. The first tool, REScheck is 

what we refer to as our desktop software. That means if you click on the link on 

the Energy Codes' website, you actually download the software to your desktop, 

and you can download a Windows version or a Mac version.  We also have a 

Web-based tool called REScheck-Web.  It offers the same basic functionality as 

REScheck desktop with a few differences because it's a Web-based tool, and I'll 

point those out to you as we go along.  There's also a third tool, REScheck 

Package Generator that I'm not going into much detail about today, but it does 

allow you as a Web-based tool to generate your own code-compliant packages 

for your windows and insulation requirements, so it's an option for you as well.   

 

 When you're REScheck or REScheck-Web, there are several main steps that 

you'll need to go through.  We're going to cover each of these individually. But 

just an overview, the first thing you need to do is make sure that you have the 

appropriate energy code selected from the Code menu.  The code that's selected 

drives many features in the software, so it's very important that you have the 

appropriate code selected before you even begin entering information because 

you don't want to get part way down the road and realize you have to change the 

code and then therefore change information you've entered. You'll then enter 

certain project information, enter building components. You'll have the option to 

enter mechanical equipment; and if life is good and your project passes, you'll 

view and print the reports and save your data files.   

 

 You'll select the appropriate code from the Code menu. Now if you don't what 

code you need to comply with in your location, at the bottom of the list is an 

option: Info, Find Your Code. If you have an active Internet connection, you can 

click on that link, it'll take you to the Building Energy Codes Program Status of 
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State Codes, you can select the - - identify the code that's appropriate for you 

and then select that in the Code menu and you'll be good to go.  The desktop 

software will remember the last energy code you used and the last location you 

selected and the next time you start a new project, those will default for you.  If 

you want different defaults or you want defaults to be the same every time you 

start a new project, you can actually go into the Edit menu and select 

Preferences and set preferences for every time you start a new project. The 

preferences are actually set up in several sections. There's a General section in 

which you can select items such as the location where you want all your files 

saved or the number of recent files that you want to show up under the File 

menu.  You also have an option to enable or disable the Beyond Code Advisor. 

I'm not going to talk about the Beyond Code Advisor much today, but it is a little 

tool that pops up and offers you information on energy efficient building practices.  

You can turn that off or have that enabled as you like.  In the desktop tool, there's 

also an option to set a preference for the software to go out occasionally and 

check our website to see if there's a later version of the software available. If you 

have this selected in Preferences, the software will not actually update your 

software version, it'll just provide you a notification that a later version is 

available.  The Project section of Preferences allows you to select a specific code 

and a location to be used every time you start a new project.  Depending on the 

code you selected, there are different entries that can be required on the 

Envelope screen and you can enable those columns to appear all of the time.  In 

the Applicant section, there's project detail information such as every time you 

start a new project, if the Applicant information is going to be the same for every 

project you enter, you can set that information in Preferences and only have to 

type it the one time.  Your options for Preferences for reports include signature 

details; and if you email reports let's say to your local Building Department and 
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you want to set that email address as a default, you can do that in the software 

as well.   

 

 So once you've selected your applicable code, you've set whatever preferences 

you want to set, now you can enter your project information.  This includes your 

project location. You'll select your state and then depending on whether you're in 

the desktop or the Web tool, you'll select your city or county. Now the Project 

Location ties into REScheck's weather data files.  So not every location is listed.  

If you come into a situation where your project location is not in the list, then we 

recommend that you check with the local Building Department as to what location 

you should use. You have a couple options. You could select a location that has 

weather similar to your project location or the Building Department may suggest 

you use REScheck-Web, which always allows you to select by county as well as 

city.  Depending on the code you've selected, you'll have different project types 

you can select.  In most cases, the project-type selections are: one and two 

family detached, or multifamily.  Lastly on the Project screen, you have a section 

called Project Details. This section is totally optional.  If you enter the information 

in here, however, for Title/Site/Permit, Owner/Agent, Designer/Contractor, this 

information will print on your reports, and it can be a useful way to track and label 

the reports that you create. You also have an option to add notes and those 

notes will also print on the report. 

 

 So we've selected the appropriate code.  We've entered our project information, 

now it's time to enter those building components that separate condition space 

from unconditioned space. This is very important because these are the 

components that the energy code is concerned with. You only need to use the 

buttons that apply to your project.  We've heard from some users that they get 
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into the software for the first time and they see all these component buttons and 

they feel the need to use all of them. You only use the ones that are applicable to 

your project.  The software is setup, as I said, to simplify compliance with the 

Energy Code, and one way it does that is that it allows you to group like 

components.  So for example, if all of your exterior walls that separate condition 

space from uncondition space are wood frames 16-inch on center with R-13 

cavity insulation, you have the option of adding up the gross square footage of all 

those walls together and adding them as one row in the table on the Envelope 

screen. Now you don't have to do that it way. It's an option for you.  If it's simpler 

for you to add every wall individually, then by all means do that.  The software 

can handle either situation.  

 

 When you're entering your components on the Envelope screen, you'll be 

selecting from a list of assembly types.  Those assembly types are driven by the 

code that you've selected in the Code menu. If you cannot describe your building 

component using one of the assembly types in the dropdown list, you have the 

option of using Other, but there are a couple caveats to that.  If you use Other, 

you're going to have to enter a U-factor for the entire assembly. So for example, 

if you're entering a wall and you're choosing Other, you need to account for both 

the insulation, air films, everything that makes up that entire assembly, and the 

other caveat is that the Code Department will likely ask you to document where 

that U-factor was derived.  So if you have manufacturers' literature or if you have 

some documentation of that calculation, then you'll need to submit that to the 

Building Department.  You enter building components on the Envelope screen 

with their gross area with one exception.  Slats on grade are entered using the 

perimeter length in feet, and the software will actually pop up a helpful little 

reminder to you for you to remember to enter it that way.  Just as a note, I've 
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talked about condition space versus uncondition space. The components that 

you're going to enter are those that compromise the building envelope.  Simply 

put, you can think of this as which components have the insulation in them and 

separate the condition space from unconditioned space.  So typically you'll have 

a ceiling component, walls, maybe above grade, maybe below grade. You'll have 

fenestration, your windows and doors, and you'll have a foundation component 

as well.   

 

 There are three buttons that relate to foundations in REScheck, so here's some 

helpful hints about which button to use depending on your project-type.  You 

want to us the Basement button if your basement is conditioned and the 

basement walls are insulated.  You'll want to use the Floor button if the floor is 

insulated and separates condition space from unconditioned space.  So for 

example, if you have an unconditioned basement and the floor above that 

basement is insulated, you would not enter Basement Walls, you would enter the 

Floor because the floor has the insulation in it.  You'll use the Crawl Wall button if 

the crawlspace is not ventilated, the crawl walls are insulated, and the floor 

above is not insulated.  There's more information in the software Help.  

 

 When you're looking at a basement situation, I just wanted to caution you that 

you want to look at each basement wall individually to determine whether it 

should be entered as a basement wall or an above grade wall.  So for example, if 

you have the wall that is 50% or more below grade, you'll enter that as a 

Basement Wall. If it's less than 50% below grade, you'll enter it as an Above 

Grade Wall. The software Help has several basement scenarios that include 

instructions on how each would be entered into the software. So if you have a 
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basement and your unsure about how to enter it into the software, I recommend 

you look at the software Help.  

 

 Finally, on the Envelope screen, I already mentioned that the entries sometimes 

change based on the code you've selected or the location you've selected.  One 

such change could be the appearance of a Solar Heat Gain Coefficient column 

that will require some entries.  Another is Orientation. You may be required to 

enter orientation and/or perhaps you just want to enter your components via 

orientation, so a couple notes related to that. First off, you want to set in the 

software what we call Front Faces.  That's the angle of the front face of the 

building relative to north.  You actually have a dropdown list of directions that you 

can choose from. If none of those work for your situation, there's also a Custom 

option, and the Help describes in more detail how you can go about using that.  

You then set the orientation of the walls for that building relative to the front of the 

building.  So the best way to do that is to picture yourself inside the building 

facing the front, then you can orient your walls front, back, left, right.  You may 

also have an Overhang Projection Factor column that appears. You can enter 

any overhangs that are showing on your plans that may shade a window or a 

glass door, for example. Again, more information in the software Help.   

 

 So we've picked our applicable code. We've entered our project information. 

We've entered our building components and now we come to the Optional 

section to enter mechanical equipment.  Depending on the code that you've 

selected, you may get a slight credit for high efficiency equipment. So let's say 

that after you've entered your building, entered all the building components, 

you're slightly failing compliance. If the plan is to install a piece of equipment that 

has an efficiency higher than the minimum efficiency for that piece of equipment, 
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you can enter that in the Mechanical screen and potentially get enough credit 

that your building would pass.  As I mentioned, this is code dependent.   

 

 Now, we get to the important part, Compliance. I wanted to talk just briefly about 

the UA compliance calculation that the software is doing.  It's a very simple U-

factor times area calculation.  It adds that up for each building assembly and 

determines an overall UA for your building. The Compliance bar at the bottom of 

the Software screen shows your UA.  The max UA refers to a building that 

conforms to the energy codes you've selected.  So if your UA is equal to or less 

than the max UA, your building passes and life is happy.    

 

 Under the 2006 IECC-based projects, things run a little bit differently, and there's 

more information in the software Help.  First off, the project-type, you'll have a 

selection of New Construction or Addition Alternation. When you select New 

Construction, the software is going to require that you enter a roof, two walls, and 

a floor, at the very least.  Once you've entered at least those components, you'll 

get a Check Compliance button that will appear.  If you've entered high efficiency 

mechanical equipment, then - - and you failed by UA, then the software will 

perform another calculation that we called a "Limited Scope Performance 

Calculation," and you may be able to pass by that.  So again, it's a little more 

complicated, but if you are showing compliance to a 2006 IECC-based code, 

then look in the Help for more information if you need it.   

 

 I mentioned the Compliance bar that's at the bottom of the screen, so you can be 

watching that to see how you're compliance is doing. There's also a Status bar. 

The Status bar can provide some very helpful information.  For example, if you 

click in an active cell on the screen, you can look down at the Status bar and it 
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will provide you information on what data is being required in that cell and also 

will provide helpful information from time-to-time if you're missing any 

information. So it's a good idea to keep an eye on the Status bar.   

 

 The software also makes use of colors, so let's do bad news first.  Red: Red is 

bad. You don't want to see red.  Red usually entails an error of some sort, 

missing information, or a failing compliance result.  Instead what we want to see 

is green. Green indicates a passing compliance result, so we always hope to see 

green.  In some cases, you may see blue.  In this example, the letters TBD in the 

compliance percentage or as the compliance percentage indicate that you 

haven't yet given the software enough information to render a compliance result.  

So keep track of the different colors you see on the screen. If you feel you should 

have a compliance result and you don't, then take a look at the screen, look for 

any cells that are red, perhaps you have missing information or incorrect or 

invalid information that you need to fix before you can get a compliance result.   

 

 In the desktop software, we also have available what we call the "Context Menu."  

If you right click in an active cell, this little Context menu will pop up and it offers 

things such as cut, copy, paste, duplicate rows, delete rows; and depending on 

what row you clicked in, let's say it's a Window row for example, Select Default 

may also be available to you.  You can use that option for your window solar heat 

gain coefficient and U-factor values if you don't have the NFRC information.  I'm 

going to talk about the NFRC label here in just a few minutes. But we're often 

asked:  What do I do if I don't have that information?  The Select Default option 

here in the software provides you access to the defaults that come straight of the 

code, so this is dependent again on what code you've selected. These are very 

conservative values however. So if you're in a condition where you're not passing 
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or barely passing, these numbers are not going to help you. In fact, the code 

official may require that you resubmit a REScheck report later that has the actual 

values that'll be installed. So use those defaults with caution, but they are 

available to you. 

 

 So if life is good and your project actually complies, you see nothing but green, 

the next step is to look at the Compliance reports.  The Compliance Report 

options do change slightly depending on the code that's selected, but you'll 

always have at least these two options:  The Compliance Certificate and the 

Inspection Checklist. You access these by the File menu selecting View/Print 

Report. Pam's going to go over in this more detail, but I just wanted to show you 

a quick snapshot of what the Compliance Certificate looks like and just briefly talk 

about the fact that the project information that you entered on the Project screen 

appears at the top.  You have a Compliance bar that's in color. Hopefully it's 

green, meaning that this project passed; although, we're told that sometimes 

people do submit reports with a red bar, which means it's a failing project. The 

middle of the screen has the building components that you entered on the 

Envelope screen.  Passing reports will include a compliance statement and a 

signature line, and then any project notes that were entered will appear at the 

bottom of the page.   

 

 The Inspection Checklist, the second report is extremely important.  The 

Inspection Checklist includes mandatory requirements that the code presumes 

are met regardless of the code that's been selected.  You'll note that on the 

Compliance Report, that compliance statement actually says that you're 

compliant with all - - everything that you've listed in the Compliance Report and 

all of the items in the Inspection Checklist.  So whomever signs that Compliance 
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Report is signing off that all of these mandatory requirements have also been 

met, so it's highly advisable that you print this out, take a look at it, make sure 

that all of these items have been taken care of and that you submit this to the 

Building Department along with your Compliance Certificate.  

 

 Just to give you an idea of some of the items that are covered in mandatory 

requirements, again these are code dependent, but they usually include moisture 

control items such as vapor retarder requirements, air leakage, items related to 

the mechanical system, service water heating, duct construction, insulation 

requirements for ducts and so forth.  So again, very important that you review 

that Inspection Checklist.   

 

 Under the 2006 IECC-based codes, there's also an option, a third option that 

pops up for a Panel Certificate.  The 2006 IECC requires that this certificate be 

posted on or near the electrical distribution panel.  It includes such things as: 

predominant insulation R-values, window U-factors, et cetera.  So whether the 

software has access to values actually input by the user, it will report those on 

the Panel Certificate. In other cases such as water heater efficiency, for example, 

the user provides no information about that necessarily but the Panel Certificate 

includes a blank line where that information can be handwritten in.   

 

 So we've gone through most of the entire process now.   You've entered your 

project. The project complied. You've viewed and printed your reports, now you 

want to make sure that you save your files.  The data file is your actual 

REScheck file, your dot-rck file, and you can save that by going to the File menu 

and selecting Save or Save As.  This allows you to keep that rck file in the event 

that you have to make a change down the road, for whatever reason, you won't 
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have to reenter your entire project.  You also want to save your report.  Now the 

report is generated as a PDF, so you'll want to save that for your documentation, 

and you can do that under the File menu by choosing Save Report. The software 

also is set up to allow you to exchange files between REScheck desktop and 

REScheck-Web.  If you've created a file on your desktop using REScheck and 

you want to open that file on REScheck-Web, you can log into REScheck-Web 

and click on the Load Project link that's at the little bottom there under the Log In 

information.  If conversely you've created the file in REScheck and you now want 

to make it available to you on your desktop, you can log into REScheck-Web and 

select Download and have that file on your desktop.   

 

 Lastly, I just want to mention our program AreaCalc. This is available in the 

desktop software. You can access AreaCalc from your Start Programs menu list 

or you can access it if you're already in REScheck desktop from the Tools menu.  

AreaCalc is a tool that simplifies the process of calculating all those building 

areas that you enter into REScheck. It's a little spreadsheet format, as you can 

see on the screen here; and once you enter the information and have it help you 

calculate your building areas, you can then transfer that information into 

REScheck, and again there's more information in the software Help on how to 

AreaCalc.   

  

 Before we get to the software demonstration, I just wanted to cover some of the 

most common questions that we've received over time from REScheck users, so 

I'm going to talk about these very briefly.  A lot of times we get questions on how 

to handle entering an addition or showing compliance for an addition in 

REScheck.  We also get questioned on the difference between cavity insulation 

and continuous insulation, and we get questions from new users about where to 
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find those solar heat gain co-efficient and U-factor values that need to be entered 

on the Envelope screen.  Additions can be tricky. The best advise that we can 

give sometimes is to check with the local jurisdiction first to ask them how they're 

going to want that compliance shown.  As far as the software's concerned, it can 

handle you showing compliance just for the addition only, or the addition plus the 

existing home.  We have information out on our website under our Resource 

Center.  We have articles about additions, and there's also information in the 

software Help. Just a side note, if you're showing compliance to the 2006 IECC 

and you're entering an addition project, you want to select Addition/Alternation as 

the project-type.  That'll allow you to get away from having to enter the certain 

number of assembly types I discussed earlier.   

 

 Cavity versus continuous insulation:  Cavity insulation is insulation that fits in the 

cavity between framing members.  So for example, fiber glass batt insulation 

between the studs, that's cavity insulation.  Continuous insulation fits across 

framing members, so example of that would be rigid foam insulation. So that's 

the major difference. So you only want to enter the type of insulation that's really 

going to be installed in the project.   

 

 The solar heat gain coefficient and U-factor values for windows and glass doors 

comes from the NFRC label that's on the product, as you can see here.  This is 

an example NFRC label. I talked earlier about using the default values from the 

code if you don't have the label available, but your best bet is to use the label 

information.   

 

 Other common questions that have come up over time relate to, for example, the 

City list. I mentioned what you need to do if your city is not included in the list.  
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Check with the local jurisdiction, find out if there's particular location with weather 

similar to your project locations that they want you to use, or maybe they'll want 

to use REScheck-Web and select the appropriate county.   

 

 We also get a lot of questions submitted through Tech Support and they'll say 

things like: "I downloaded the software, but I've got the 2000 IECC version and I 

need the 2003 IECC version." We have one generic version of the software and 

what you need to do if you have that question is go up under the Code menu and 

select the applicable code.   

 

 We also have been questioned about why some mechanical equipment is not 

listed in REScheck, and that's because the software only makes the most 

common equipment types available for trade-off, and those are the types that are 

covered by a federal appliance standard and are rated with an AFUE, a SEER, or 

an HSPF.  So there are other types such as radiant floors, geothermal heat 

pumps, et cetera, that require complex calculations that REScheck is just not set 

up to do.  So if you want to try to get credit for those types of systems, your best 

bet is to use a different piece of software that can accommodate a whole house 

performance analysis.   

 

 So that covers some of the most common questions that we've received, gives 

you a quick look at the basics of REScheck, and now I'll turn it over to Pam to do 

a software demo.  

 

Pam Cole: Thanks, Rose.  I'm going to show the actual desktop, the one that you can 

download to your desktop, and we're going to go through that and address some 
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of these things that Rose did as far as the application goes.  Give me a second 

here to load the actual program.  Is it on there? 

 

 All right, the first thing that'll come up when you have the desktop loaded is it will 

come up with a popup that's going to ask you:  What code is applicable?  This is 

from - - coming from a lot of typical questions that have come in because it will 

default to a code automatically when you open it for the first time.  So if you don't 

know the code and you are connected to the Internet, you can go look up your 

code from this menu right here. If you don't want to see this screen every time 

you open up the software, you can just click Off, Do Not Display It and hit Okay 

and it'll go away and it won't come up anymore.  

 

 I'm going to expand the software so over to the right top, I actually expanded it so 

I can see the entire software application on my screen because the more 

information that you enter in the Envelop tab, you might not see it if you don't 

have the entire software expanded.  So let's go look at - - take a look at the top.  

The top bar on the left-hand side says, "Untilted.rck.  That's because I just 

opened up the software and I don't have a data file saved, so it will actually say, 

"Untitled.rck."  If I was to go open up a data file, it would say the name of that 

data file with the dot-rck extension.  The next thing you will see is the REScheck 

and the version number; and again this version number is, if you have an old 

desktop version or so forth, it's going to tell you exactly what the version number 

is.   

 

 The next thing on that Title bar is the code that is defaulted from the Code menu 

when you open it up.  It's a good thing to get in the habit if you're using 

REScheck quite a bit is to look at that, especially if you're dealing with projects 
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across the states that have different codes adopted.  This one shows the 2006 

IECC. The next bar is the actual menu, so you'll have the File, Edit, View, 

Options Code, Tools, and Help.  In the File menu, this is where you can save 

your data file. You can save your report.  You can view the report, and you can 

email the report right from in this tool if you're connected to the Internet.  In the 

Edit menu, you have the typical Windows application features that are the Cut, 

Paste, and so forth, Delete Rows, Duplicate Rows.  But you have that 

Preferences that Rose mentioned, so let's go into that.   

 

 In the Preferences, this is where if you put any information in here, it's going to 

automatically show that every time you open up REScheck.  So you have to be 

careful; if you don't want to show it every time, then don't put any information into 

the Preferences.  But if you want to customize your reports and projects and you 

want to have it there every time you open up REScheck, you can do that within 

the Preferences.  So here's the tabs that you'll get.  General means if I want to 

default to actual file options, if I want to see the Beyond Code Advisor or I don't, 

you can disable it there; and if I want to know about any version updates, I can 

make sure that I have this on so if there is a new version that comes up, it's going 

to tell me:  Hey, there's a new version; go download it.  In the Project area, in the 

Project tab of the software, you can actually default, the same code will come up 

every time, the same state and the city if you want.  So every time you open up 

the software, it's going to put that state and that same location so you don't have 

to choose it every time you go into REScheck.  You can also under the envelope, 

I can enable Orientation, Overhangs, if you have the applicable code chosen, 

and then I can show comments. 
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 I'll show you where the comments actually fit in the Envelope tab.  Over on the 

Applicant screen, or the Applicant tab, I can actually customize my Owner, my 

Agent, so I can put in: If it's me, I can put my owner name and agent and I want 

that to show every time. The Designer, if I want the designer to show up every 

time, I can do that as well.  Over on the reports, this is a really nice feature that 

we've added where actually you can customize the report signatures, and we've 

been asked that we want more than one signature line.  Maybe you have an 

architect or you have an engineer and you want all of those signatures on there 

and you want to customize their name and title, you can do that from within here.  

Down at the bottom under Email Reports, if I'm emailing my reports to the same 

building official for everything, then I might want to put in his or her email address 

in here and my email address so I don't have to type it in every time I go to send 

a report to them.   

 

 Up at the top again under the View menu, you have Toolbar and Status Bar. 

That's the toolbar that sits here, the status bar that's down below. You probably 

don't ever want to uncheck those, and then you have Glazing Requirements. 

Now you might not see the Glazing Requirements. That's applicable to the 2006 

code only and it actually brings up the screen and it'll tell you the calculations that 

you've entered. Right now there's nothing entered, but it actually will show you 

your area weighted average for your solar heat gain and what's allowed, so this 

is code-driven for this menu.   

 

 Under Options, again you have the Orientation and you have the Comments 

Description.  If I click on the Envelope tab and I go back to Options, I can enter 

the Orientation and it'll bring down another column, which is right here between 

the assembly and the gross area, click on Options again and I can go to click on 
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Comments and Descriptions and I get another column where if I have some 

unique type of wall system or so forth, I can start adding some additional notes to 

the assembly types that I'm starting to enter so that will show up on the report 

which makes it easier for the plan reviewer to review your project.  The Code 

menu that Rose had mentioned, there's several national codes within this 

software of which the 2006 IECC and IRC are the most recent ones, and we 

have some state-specific codes that are in the software as well. If you don't know 

your code again, as Rose had mentioned, that you can actually click down here 

where it says Info, Find Your Code, if you're connected to the Internet, and go out 

to the Status of State Code pages on our website and click on the state that's 

applicable and that page will tell you what code is adopted within that state and 

whether they can use the tools.   

 

 Under the Tools dropdown menu is the AreaCalc Take-Off Tool. I’m not going to 

show it today, but basically what that tool is:  You can actually save all your 

windows and doors in a library and then pull in those windows and doors into 

your schedule, the ones that you're using.  You can calculate your walls, your 

ceiling, your floor area with the particular assembly type and then you can 

transfer that information from AreaCalc into the desktop version.  The one thing 

you need to pay attention to if you start using that tool, when you transfer 

information over and you have a lot of windows, it will take all those windows and 

it's going to throw it in the first wall it sees because it doesn't know where to put 

those windows.  So if you have more than one wall component entered, pay 

attention to that if you're using that tool because it's going to throw all those 

windows and doors under the first wall component that it sees, and I'll show you 

that when we get to the Envelope tab in the software.   
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 Under the Help section, this is where you can go in to the software Users Guide if 

you have questions, if you want more information on an assembly type or how to 

enter it, or how to enter the square footage or how to calculate the square 

footage, all that information sits under Help Topics.   

 

 Next bar down is the Windows type functions, which is your New, Save your file, 

Cut, Paste, Duplicate Rows, Print, and I have turned on Orientation so now you'll 

see that it says Front Faces. This is where you can define all of your walls based 

on orientation.   

 

 Now down below that bar is our actual tabs that we can start entering our 

information, so you have Project, Envelope, and Mechanical. In the Project tab, 

you have your Location. So if you have your location specified or you have it in 

your Preferences defaulted, then you don't need to change anything there.  

Project Type, you have the option of New Construction; and Addition/Alteration, 

this is code driven so only on the 2006 IECC would you even see that option 

because that option is only for that code that we have available for there.  It's a 

really nice feature, makes it much easier to show compliance to an addition; or if 

you're doing a renovation to an existing residential building, you can use that tool 

or that feature.   

 

 Building Characteristics, One- and Two-Family/Multifamily.  One thing to mention 

here is if you do have multifamily, then you will not have the ability to get credit 

for any high efficiency equipment.  Your building must comply by UA-only, and 

that's the U-factor times the area. You can enter high efficiency equipment in the 

Mechanical tab. That's still optional, and you can still show it on your report, but 

you'll see that you will not get credit because with multifamily of course you got 
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multiple zones, you have multiple pieces of equipment, so that's not applicable 

for getting credit for a multifamily building.   

 

 The Conditioned Floor Area is driven by the 2006 code. This is where I will enter 

every floor that's conditioned, not just the bottom, not the bottom floor. If you 

have a two-story occupied conditioned house, you're going to total up both floors 

and put it in there, so total conditioned floor area. This is really nice for plan 

reviewers because the first thing they can take a look at it is: What's the total 

square footage of this house that they're showing compliance to?  So it's a nice 

feature for the first thing to take a look at when you're reviewing them because if 

they were by chance didn't enter all the Envelope components that they needed 

to, that's a true sign right there to look at the total square footage of the 

Conditioned Floor Area that can give them the first item to say, "No, this is a 

3,000 square foot house; I don't see how they have 1,000 square foot floor over 

on conditioned space. That doesn't seem right to me," and then they can take a 

little bit more detail into the report, into the building plans to see what's going on.   

 

 Over to the right is the Project Details.  So if I click on the Edit Project Details 

button, then I have three more tabs that appear. Now if I enter information in here 

that's not the same as the Preferences that I just showed you, this will only be 

applicable to this project and you'll save it; and then of course if you open this 

data file again, it'll be there. But if you leave REScheck and come back, this 

information won't be there if you start a new project, only the Preferences if you 

enter this information.  So the Title, Site, and Permit, I can enter my residents 

that I'm dealing with and all this information will show up on the report - the 

address, permit number down below, permit date, and so forth, any notes I want 

applicable to this project. Over under Owner/Agent, the same as Preferences but 



   
REScheck Basics 

22 

this is only specific now to this data file that I would start creating today, and I can 

enter my owner name and agent.  I can over to Designer/Contractor and enter 

who the architect is and so forth, any notes and then hit Okay.  That will populate 

over on to this Project tab screen as I showed you.  Up at the top here, 

Title/Site/Permit, you'll see Jones residence and a permit number.   

 

 Down at the very bottom of the screen is a bar that says, "No Envelope Assembly 

Specified."  Keep… Pay attention to this area because this is where it's going to 

give you little teasers for if you're missing information or it needs more 

information to calculate the rest of your building envelope. The reason why this is 

saying it in blue is because I haven't even entered any envelope components yet.  

So it's telling you: Hey, I can't calculate anything yet.  You don't have anything 

entered in your Envelope section.  The UA Tradeoff down below that and 

equipment performance, this is code driven. You'll only see this if you're on the 

2006 code, is saying TBD, To Be Determined, because I haven't entered any 

data yet. If you're not on the 2006 code, what you would see down here is the 

max UA and your UA, and of course it's at zero.  When I start calculating a 

building here in a second, you'll see that that's going to start adding up some 

numbers here.  The max UA, as Rose had mentioned, is the max UA that you 

can get to when it starts.  When you start defining your building envelope, it's 

looking at the actual code and comparing it for code building against your 

proposed building, which is your UA.  Over to the very right is the percentage.  

So if you are a plus, of course that's passing; and if it's in red, it's going to be 

negative and it's going to be failing.  Right now, again, it says TBD, and the little 

arrow button that you see over to the very far right, that's that little Above Code 

Advisor, and you might want to play around with that.  That takes you at the 

Internet.  It'll take you to Above Code Features. It'll take you to if you're wanting 
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information on a ventilated crawl space or mechanically ventilated crawl space. It 

can take you to a lot of good information to our Resource Center on optional, on 

additional information when designing your project.   

 

 Let's go over to the Envelope tab.  At the top what you see is some blue and 

white buttons that you can start running your take-offs for the exterior thermal 

building envelope. This doesn't mean that you're entering interior walls, interior 

floors between conditioned spaces.  You're looking at your building plan and 

you're running your take-offs.  For the area that defines that exterior building 

envelope whether it's up against uncondition space such as a garage or outside 

air, those are the components that you start defining.  Now not all these buttons 

may not apply to your project, but each one of them has a dropdown list of 

assembly types that you can choose from.  The assembly types that are listed in 

this software already have a calculated U-factor.  If one of them does not match 

your assembly type, then you always have the option to choose Other. But when 

you choose Other, then you have to define out the overall U-factor for that 

assembly; and most likely you're going to have to provide documentation to that 

code official and how you calculated that U-factor, manufacture specifications 

and so forth because he's probably going to want to see that.  If I have my 

construction actually is similar to one of these in this dropdown list, so if I choose 

Flat Ceiling Scissor Truss and I would then look at: Okay, where am I placing my 

insulation in my ceiling?  This is a lot of confusion for users when the first time 

they're using this tool when it comes to ceilings; and typically with residential 

buildings, you're placing the insulation at the ceiling level, not the roof deck and 

that is how you define the square footage, not the roof deck, not the pitch of the 

roof.  You're doing it at the flat ceiling level.  So I'm looking at my square footage 

for a ceiling and let's say it's typically the same as your floor area, so I put in 
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2,000 square feet.  Now again with ceiling, you're not separating out the 

insulation if you're doing one application. If I'm blowing in cellulose at R-38, it all 

goes under cavity.  Even though there's going to be so many odd inches of 

insulation that will be continuous above the trusses, the software already 

calculates that based on the R-value that you are entering there.  It also 

calculates, and I'm putting 38 in that cavity area right now. It also calculates the 

decreased amount of insulation towards the eaves.  If I was to put that under 

continuous, it's assuming full height insulation, so be very careful that you don't 

separate out your insulation in between these two columns here when you're 

dealing with the ceiling.  I've entered the 38; and as you'll see, the U-factor has 

changed. I'll show you another component where I don't enter the insulation and 

it already has the U-factor calculated without insulation.  Then it provides the UA, 

U-factor times area for that component.  Again, I can click over on the Comments 

Description and I can enter additional information if I'd like to.  Let's go ahead 

and enter a wall. I’m just going to assume that I have wood frames 16-inch on 

center. There's several other features of wall components that you can choose if 

they're applicable to your project.  When I entered that wall, over where the U-

factor column is, it says a 0.238.  That includes a series of assumptions in the 

software, and we do have a Technical Support document that you can go to out 

on our website if you really want to know exactly how REScheck calculates 

everything in this software, it's all in there.  It will tell you what we use for the R-

value of gyp board. It will tell you what the R-values we use for air films, inside 

interior air films, exterior air films. It will calculate or it's going to tell you all the 

calculations that are on the back end of this software that are making it easier for 

you as the person that's entering this information for compliance.  So let's take a 

look at this wood frame wall, I'm going to enter some square footage here. Now 

the square footage of the wall, that includes any fenestration.  Do not subtract out 
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your windows and doors.  You will take the exterior wall component.  The 

software does that for you as well.  That's a calculation that we run; and it's 

starting to calculate your percentage of glazing, which is your window to wall 

ratio, by you entering your windows underneath that wall. It will treat your walls 

and windows as of like a parent/child relationship, so do not subtract those out. 

You do the opaque area of all your exterior walls, then you will enter your cavity 

and/or continuous.  Continuous insulation for your exterior walls is if you're using 

rigid foam board on the exterior or you're using insulated sheeting. If you're doing 

typical sheeting, that's already calculated in the U-factor of the 0.238.  You don't 

need to enter that.  It's only if you're doing insulated sheeting and then it actually 

runs at assumption knowing that you're using insulated sheeting, so if I had R5 

here, and it's going to subtract out the default of the sheeting that we use and 

use your R-value.  So be careful not to enter additional R-value or R-values of 

materials that are already calculated into that wall.  So again with my cavity 

insulation, one more thing to mention about walls is: How does it know if it's two-

by-four or two-by-six construction? It's based on the R-value of the insulation that 

you enter under cavity. If I enter 15 of greater into the Cavity column, so if I enter 

R-19, it's running a calculation as though that's a two-by-six wall and it's -  - and 

that's a little different than a two-by-four because of your framing members and 

the R-value that we actually assume for a two-by-four versus a two-by-six. Again, 

if you want that much detailed information, you can go to that Technical Support 

document.  When I entered the cavity insulation, you'll see that U-factor that I 

said, 0.238, is now down to 0.06 and then it has a provided me a UA of 60.  So I'll 

enter one window here and in your windows, you will define what type of window 

it is - wood frame, double pane, Low-E, or so forth. That doesn't trigger anything 

by defining that window.  What triggers the calculations in the software is that you 

U-factor and solar heat gain if applicable, if you have the applicable code on. You 
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might not even see solar heat gain coefficient if you're on an older code.  The 

windows how you're calculating those is the rough opening, same as doors, 

because the U-factor, hopefully, you're taking it from the NFRC rated product, is 

the framing plus the glass. That's how they rate those.  So you're taking the 

calculation as the rough opening; and let's say you don't have that NFRC rated 

product, you do not have those ratings on your windows, if I take my cursor and I 

click in the U-factor cell and I right click, then I get that dropdown menu that Rose 

had mentioned where I can select defaults. These are not favorable defaults. 

They come right from the code. They are worst case scenario.  So if I take a look 

at this menu that comes up and I'm trying to look for:  Well which one would be 

most applicable to this window type because I really don't know what the U-

factor, the rated U-factor is and I say it's a double pane non-metal window and I 

clicked on 0.55 and I hit Okay, it's going to populate it into my actual building grid 

that I'm working on here. The same with the solar heat gain, I can right click and 

select a default.   In your climate zones that are coolie dominated with high 

cooling degree days, these defaults will not even meet code. That's why I say 

pay very careful attention to using the defaults.  They won't work for a lot of 

climate zones, meaning that you will not meet compliance by using them.  You 

can run a project if you want and you don't know what windows they've picked 

out yet, but they could play a big part of compliance if you're using these defaults 

and there in areas that have really strict U-factor and solar heat gain 

requirements.  So I'm just going to select one and it's going to populate it into that 

Solar Heat Gain column.  

 

 Let's go take a look at basements. I’m going to click on the Basement button and 

I'm going to choose the first one at the top, the solid concrete masonry.  Again, 

do I have a basement that's conditioned? If I do, take a look at those walls.  
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Basement walls considered in the code below grade walls, the definition of that is 

that if that wall is more than 50% below grade.  So what it's going to ask you for 

here is: It wants to know the wall height, so I'm entering nine-feet. It wants to 

know the depth below grade of that wall and it should be 50% or more if you're 

dealing with a basement wall, so I'll put five-feet. The next thing it's going to ask 

you is your depth of insulation.  In the newest code, the 2006, the minimum 

baseline for insulation is full height.  In the older codes, you could actually 

insulate maybe three-quarters of that wall and still not have too much of a 

problem meeting code.  It's going to get a little bit harder to not have full height 

insulation on those basement walls in these newer codes, so I'm going to put full 

height insulation at nine-feet.  So I put nine in there and I hit Okay.  Then it's 

giving me more columns into my building and assembly components that I'm 

starting to enter here.  So now I have the wall height, the depth below grade, and 

depth of insulation columns that have been added. That's why I said expand 

software as big as you can on your desktop so you don't start missing or seeing 

some of these columns as you put more information into your project.  With 

cavity and continuous on basement walls, I'll quickly tell you that there is another 

assumption that is done here. If I was to put continuous insulation only for my 

basement wall, the software assumes that that's exterior ridge of foam board and 

will run the calculation as such. If I put cavity insulation, well of course it's going 

to assume that you're furring it out to the interior and then that's on the inside of 

the basement wall. So pay attention to that one as well.   

 

 Under the Floor button, I have some options on how I'm doing floor. Before I 

show a floor over unconditioned space or outside air, if I have fully below grade 

basement and I don't have any other floors that are over unconditioned space 

such as somewhere else where I would have a crawlspace, a vented crawlspace 
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or a cantilever or some area that I have a floor that's over outside air, if you have 

a foundation that's greater than 12-inches below grade completely, not a walkout 

basement, you will not show a floor in the software because a foundation that is 

greater than 12 inches below grade does not have any insulation requirements 

and by you putting in basement wall components into the software, another 

assumption is done that the software assumes that this is a fully below grade 

basement, so pay attention to that one as well.  If I had walkout basement, then 

I'm going to have a slab-on-grade. I’m going to have an exposed edge of slab 

that I'm going to have define.  So if I click on Slab-On-Grade and I say 

unheated… Heated means I have hydronic heating within the slab, some sort of 

hydronic system or whatever that I'm heating the slab with and I would choose 

Heated.  I'm going to say Unheated and what happens is you'll see another 

screen that comes up and it's going to give you a series of pictures or graphics to 

say, "How you insulating it?" Another good point is: What if I'm not insulating it 

but I still have a walkout basement or I have a slab-on-grade that that is above 

grade or not greater than 12 inches below grade such as a lot of construction in 

Texas.  They deal with slabs.  Just because you're not insulating that slab 

doesn't mean if it's still part of your building envelope, you don't show it.  You 

would still enter it.  You're going to show no insulation; and dependent upon the 

climate location, it will know based on that climate whether insulation would apply 

anyway. But just because you're not insulating and it's still part of that building 

envelope doesn't mean you don't show it.  So with that, if you're in a higher 

heating degree day climate, you're probably definitely insulating your slab, and I 

can click in that box up there and I can say, "All right, I got four-feet. I got four-

feet depth of insulation and I hit Okay and just because I put depth of insulation, I 

got to go back over enter the linear feet-only. This is the only component within 

the software where you're entering it in linear feet, not total square footage, is the 
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exposed edge of the slab.  So typically for a residential building, it's going to be 

100 or less or right within that range.   

 

 Then I'll come over to the Continuous Insulation column and I'm going to enter 

the R-value of the rigid foam board that I'm dealing with, maybe it's five, maybe 

it's ten, typically most are around the five to ten range.   

 

 The Crawl Wall button up at the top, this only applies if you have a crawl wall that 

that crawl area is not vented to the outside, it's mechanically ventilated, and it's 

conditioned.  It's a conditioned crawl. It's a mini little basement.  That's the only 

time you're going to enter that - - these components.  With the crawl, if you do 

have a non-vented crawl wall, you would not show the floor above the crawl 

because that floor would then become an interior floor; it wouldn’t need to be 

insulated because you're insulting the crawl walls.   

 

 So a couple more things to note on the crawl wall. Let's just pick the first 

dropdown assembly type here, Solid Concrete Masonry, and you'll see it's going 

to ask you one more piece of information when you have a crawl wall. You have 

the wall height. You have the depth below grade from the outside. You have the 

depth of insulation, and now you have the depth below inside grade, another 

calculation that the software runs for crawl walls.  So pay attention to that if you 

do have crawl walls that you're entering as part of your project.   

 

 Let's go over to the Mechanical.  In this section, this is where you can actually, 

and it's optional, you can enter your information. If you choose any one of these 

type of systems here, it automatically has defaults at the minimum efficiency for 

that piece of equipment.  How you change that is that you click where the 
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efficiency is, so the 78, I can click there. I can highlight it and delete it, and I can 

enter what my efficiency is for the system that I'm specifying. You can enter 

multiple pieces of equipment, but be careful with that because if by chance you're 

trying to get some sort of credit, if applicable, for high efficiency equipment, it 

won't do it for multiple equipment, and you can get more information in that in the 

Help section.   

 

 So let's go back over and I'm going to open up an actual data file that we're going 

to play around with.  Give me a second here.  Now I've created a data file that's 

an actual case study that's out on our website that we've had out there for quite 

awhile that shows you all the components. This actual residential building has a 

little bit of everything.  Now I'm going to expand it here.  This one, the code at the 

top is the 2006 IECC. I've defined my front faces because I have orientation 

involved.  In the Project tab, I have all the information that I want to show up on 

my report.  I got my conditioned floor area entered, which is a biggie.  Let's go 

over to the Envelope.  I have my ceiling, my exterior walls. There's some knee 

walls that you'll see right here, 11 and 12. If you do have knee walls that are 

separating that attic from your conditioned space, you needed to show those as 

part of your project and they need to be insulated.  I have some basement 

components because my basement is conditioned; however, I have a walkout 

basement so I've got a slab-on-grade.  The other part of this building envelope, I 

have a floor over unconditioned space; I have a crawl so that sits on the other 

side of this building.  

 

 Well let's go down here and down at the very bottom, let's check compliance 

because right now I don't know if it passes or not. I can look at the max UA and 

your UA and it looks like my UA is higher than the max. Most likely this project is 
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failing. But I have to click the Check Compliance button. Now that's only 

applicable to the 2006.  If you were on a different code, it would show you 

automatically what the compliance results are. I’m looking over to the right and it 

says, "Worst Than Code, 2.2%."  Not too bad.  I might find something in my 

project that I can work with to get this into compliance.  So the first thing I'm 

going to do is come up to the top and look at this UA column. I’m going to go 

there first and I'm going to look at my big hitters. I've already reviewed my 

building plans to make sure that all the components that I've entered are correct.  

The square footages are correct. I got the right insulation values. I have the right 

U-factors and/or solar heat gain coefficient, if applicable.  So now I'm looking at 

this UA column going:  All right, what I can do to this project to get into 

compliance?  I'm going to the UA because the bigger the UA, the bigger it's 

hitting towards my proposed UA down at the bottom.  So I have an 85, got some 

smaller ones. I've got 129.  That's probably the biggest one there, but I'm looking 

at that component and those are some pretty darn good windows. They got a 

really good U-factor and the solar heat gain, that's not bad either.  So I'm not 

going to mess with that one yet, let alone I probably have my client who doesn't 

want replace those. Maybe they're already set that they've picked their windows 

out and that's just going to be part of the project. Sometimes that does happen. 

 

 Let's keep going down the line and I'm looking for some big UAs, so I have down 

at the very bottom my slab is 75.  So let's go back up to the top. I’m going to take 

a look at the UA that says 85.  So that's my ceiling, and it says, "I'm proposing 

cavity insulation of 30."  I can do better than that and probably would need to do 

better than that if I'm in a higher climate zone with some high heating degree 

days because from the 2006 code, the minimum baseline for Climate Zones 5 

and higher starts at R-38.  So I'm going to change this. I got a 30 there now, now 
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watch as the compliance does change for this project. So I'm going to put in 38, 

the U-factor changes, the UA went down; and down at the bottom, it says TBD 

because I have to force myself to click Check Compliance again.  So I click the 

Check Compliance button and now I'm passing.  But I can only pass somebody 

0.0% better than code.  I’m wondering, and that's fine, you can submit a report 

that shows 0.0, but is there anything that I could do better on this building?  Is 

there anything I can do to save more energy and make this building more energy 

efficient?  So I'm going to go back down this column and go to my third highest 

UA hitter which is the slab-on-grade.  With that, I'm proposing a depth of 

insulation at two-feet; and if can feasibly get four, then I'm going to put four. The 

software will max out at six-feet. If you are insulating entirely underneath a slab, 

you'll see that you can't account for that in REScheck because it actually has a 

limit - - limiter and some of the reasons being is because the more you insulate 

towards the center of that slab, you decrease the amount of energy usage that 

you're going to have heat loss towards the center of that slab anyway and it's 

code-driven.  So I'm going to enter four-feet and it again says, "TBD" down at the 

bottom so I can Check my Compliance box again and I'm 1% better than code.  I 

might play around with this project a little bit more and see if there's something 

more I could to get this building more energy efficient than 1% better than code; 

and hopefully in your projects, they sit at 20 to 30% better than the most recent 

2006 IECC.   

 

 I can go over to Mechanical and I can enter mechanical information again. It's 

optional, but this building's passing. If I want to show my systems, I can, but I'm 

passing by UA so I could actually go up to File.  I can view and print my report. I 

can email my report, and first thing I probably want to do is save it.  So I want to 

save this as a data file first, dot-rck, and then I'll probably save it as a report 
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which creates a PDF that you can open in Adobe and print it from there.  But I 

can go ahead and click on Email Report and it'll ask me: Well what do you want 

to email, the Compliance Certificate, Inspection Checklist, Panel Certificate?  

Typically you can email all that if you'd like.  I can create it as an RTF. This is 

something that's mostly applicable people that are dealing with CAD versions, 

and I won't get into that right now. But if you do have questions, I can answer 

those live.  Then I can hit Okay.  So I want to email this to the Building 

Department, it's going to bring up that screen that I showed you where if you 

don't put this in your Preferences, the recipient's name and the email addresses, 

of course you're going to have enter it every time that you're doing a project, so 

that's what's nice about that Preference option.  So I would go ahead and enter 

all this information and I can click Send right from in this tool if I'm  connected to 

the Internet.  So that makes it pretty nice that you don't have to drive this report 

down to the Building Department. If they accept it via email, you're great, and 

then you can just deal with them over the phone; or if you have to change 

anything to your project, you can do this electronically.  

 

 Let's click out of this. Next thing I'm going to show is the actual project reports.  

So let's go back over and I'm going to show you the same project, the data file 

that I had in REScheck as an actual report now.  I need to pull this up real quick.  

As I had mentioned, when it's a report, it creates it as a PDF.  So now I'm looking 

at the actual Compliance Certificate showing me the version number at the top. I 

have all my project detail information within this Compliance Certificate.  When I 

mentioned to you the glazing area percentage, it's calculated, 18%.  It shows you 

the heating degree days, the climate zone, and then it's telling me whether it 

passes.  Down in the middle section is the actual assembly types. Now if I'm 

looking at this report and I'm the code official, I'm going through this and I'm 
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looking at my building plans and I'm making sure the square footages are correct, 

that they've specified the correct assembly types and the construction type of that 

assembly, that their insulation levels have been entered properly, cavity and/or 

continuous. I'm looking at those. I'm looking at the specs on alter fenestration, 

making sure that the U-factor and/or solar heat gain meets the specifications that 

they have sent into me, and I'm going through this list and I'm going through it 

and making sure that all this information is correct because it could be one thing, 

especially if it's close to compliance that would throw this into non-compliance, 

especially if it's a square footage of a certain component that's just barely 

meeting code.  Again, I'll want to make sure that they've signed the Compliance 

Certificate, and I'm going to keep scrolling down here and I'm going to the 

Inspection Checklist.  I always suggest to everyone, the designer who submits 

these reports, they print this Inspection Checklist and they review it carefully 

because it's going to show everything they've entered in the data file.  As you'll 

see, the above grade walls, it's showing the R-19. That's what was specified in 

the data file and on the Compliance Certificate.  But if I come down here a little 

bit further and I'm scrolling down to air leakage, sunrooms.  Now with this, if 

sunrooms are not applicable, then you probably want to write N/A.  You can't 

manipulate these Inspection Checklist reports, but on your report before you 

submit if you're submitting it by hand or you want to make a note, you could say, 

"Sunrooms are not applicable."   Vapor retarder and if you want to add additional 

information on your vapor retarders, but this information that sits below the actual 

components that you've specified in the software, this stuff is critical and it's still 

applicable to your building. The big one is: duct insulation, duct construction, your 

thermostat controls. You can't trade-off duct insulation in REScheck.  It's 

mandatory.  In the 2006, duct insulation starts at R-8. The other thing that you 

can't trade-off in REScheck is: What if I have some great air barrier insulation?  
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The software already assumes air infiltration. It has an air infiltration value within 

the software; and so if you have components that have some air barrier features 

that are good that make that component that much better than your typical other 

insulation products, so to speak, you can't show that in REScheck.  REScheck is 

a very simplistic tool that is just U-factor times area, the assembly with the 

insulation, the assembly with the U-factor and the solar heat gain of your 

windows.  Anything above and beyond this type of showing compliance, which is 

a trade-off for the U-factor times the area, you'd have to use a performance-

based tool to do that, and then you can start defining out the more additional 

features of your project with a performance-based tool. REScheck is not a full 

performance-based tool that does not show energy usage and energy savings.  

 

 With that, I'm going to turn it back it over to Rose, and I think we'll begin starting 

to answer some questions.     

 

Rosemarie Bartlett: Well, the U.S. Department of Energy would like to thank all of you for your 

attendance today, first off.  Before we begin answering as many of the questions 

that have come in as possible, I'm going to ask Pam to go back to our last slide 

here which includes the link that you can use to complete an evaluation and 

provide us with your AIA information or print a Certificate of Completion.  You 

cannot click on this link directly into Live Meetings, so you'll need to write this 

down.  Any of the attendees, if you're in a group watching this webcast together, 

everyone needs to write down this link and you can all go to it individually and 

complete the information there.   

 

 Now for the questions.  We have several that have come in. I have a stack and I 

have a stack for Pam, so we're going to start answering those, and we've got 
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more questions coming in.  So we'll do our best to answer as many that have 

come in as possible. If we do not get a chance to answer your question, you'll get 

an email from us hopefully in the next week or so. There are a few questions that 

came in that were very specific to a very specific situation that the listener has 

and so we'll not answer that one live, those live. We'll get back to you individually 

on those.   

 

 So first off, does gross square footage mean without window and door openings?   

 

 Gross square footage means everything. So if you're entering the gross square 

footage of a wall, you're going to include the windows and doors that are in it, 

those areas as well, so include everything.  The software will handle removing 

the areas for the windows and doors and so forth as it's doing its calculations.   

 

 Do windows have to be entered below the wall they appear in? 

 

 Well that depends on how you're entering your building components. If you are 

entering let's say every wall separately, then, yes, you would want to put the 

applicable windows and doors underneath the walls in which they occur. If you're 

grouping all of your exterior walls together in one row, like we mentioned you 

could do, if you have - - if all your exterior walls have the same construction 

characteristics, the same R-values, et cetera, and you group them all together in 

one row, then it won't really matter because you'll just have one wall row.   

 

 We had a question that came in about midway through that: What is UA? 
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 And I think we've talked about that a few times, and Pam mentioned it again in 

her section as well. But just as a refresher, the UA approach that the software 

uses, UA just means the U-factor times the area of each assembly.   

 

 With that, I've answered a few; I'm going to let Pam answer a few, and I'll keep 

looking at the questions that have come in. 

 

Pam Cole: All right, one of the questions was:  When doing a duplex, is it done by the 

building or by units?   

 

 I would highly suggest when doing multifamily or you got a condo unit, do the 

entire building project.  It is a lot harder to do individual units and achieve 

compliance in individual units because you've got those common walls between 

the units that would not be entered into the software. They would be considered 

interior walls, even though they're between two different occupants.  So the 

easiest way is to show that entire building first off when it's built, the entire 

structure, so you'd run the take-offs for the exterior building envelope of the entire 

structure. 

 

 Next question is:  Geothermal heat pumps or air source heat pumps included in 

the list? 

 

 Air source heat pumps are included in the list, and you can define those in the 

mechanical system and their efficiency levels, the SEER and the HSPF.  

Geothermal is not included in the list.  Typical systems that come from the code 

that have their minimum efficiencies such as the air source are there.  The 

reason why geothermal is not there is because that is code-driven that if by 
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chance you were trying to achieve some sort of credit for mechanical efficiency 

equipment, the geothermal systems does not provide that option because they sit 

at such a high efficiency to begin with, there's not option to get any credit towards 

that building envelope. Now how would you about showing it if you do have a 

geothermal system that you are putting in with a project that you're showing 

compliance to? You have some options. You can show it. Go to the Project tab 

and show it under the Notes. Put all your detail there. You're still going to have to 

provide all the loads and the design of that system to the Building Department, 

but you could have it on the report in the Note section.  

 

 Another question:  We work with builders who run continuous insulation under 

the slab.  Can we get credit for that, or how would we calculate and enter that in 

the REScheck? 

 

 As I had mentioned, there is a limit on the depth of insulation that you can put for 

your slab-on-grades into the software. That's code-driven again because you 

can't receive credit over a certain amount of depth of insulation; and the software, 

what's it's doing is it's calculating trade-offs for you.  There is no trade-off over a 

certain limit for slab-on-grade if you have full - - if you have a fully insulated slab. 

That doesn't mean that you can't account for it. The way you account for it is 

you're going performance-based and maybe you will achieve some credit for 

having a full insulated slab because you're basing that now on an energy 

savings, not on just the U-factor times the area.  So that's how you'd go about 

showing a fully insulated slab. 

 

 Next question, and then I'll send some over to Rose.  Does REScheck account 

for spray foam insulations ability to also function as an air barrier?  Since spray 
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foam is usually applied to the underside of a roof deck, is it entered in REScheck 

as a cathedral ceiling?   

 

 First part of that question is:  The spray foam air barrier features, which of course 

are really good, but there's no way to account for that feature in the software. 

You can't show those air barrier features because of that type of product. You 

would have to go performance-based and now you're looking at the entire 

building to show that type of air barrier that that product has. 

 

 The next part of that question was: If I'm using spray foam and I'm applying it 

under the underside of the roof deck, would you enter that as a cathedral ceiling?  

 

 You have some options and you can look at choosing Other as your ceiling 

component and entering the overall U-factor of your ceiling, but make sure that 

you are putting the U-factor of your ceiling component as to where the insulation 

is placed.  If I'm doing spray foam at the roof deck and that defines my exterior 

thermal building envelope component, then I'm calculating the roof deck as part 

of my U-factor area, and then I'm going to back that documentation back up to 

the code official on how I came up with that U-factor. The other way you could do 

it is… I don't want to go into a lot of detail because, again, code-driven is 

cathedral ceilings and so there are some mandatory requirements and some 

limitations when you get into cathedral ceilings in the 2006 code.  So I guess I 

would favor on the side of not using cathedral unless you truly look at how 

REScheck is calculating these type of ceiling components, and you can go to that 

Technical Support document to look at those to see how you want to show that 

spray foam. 
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 Rose, you want to answer some more questions? 

 

Rosemarie Bartlett: Sure.  Man, they're just coming in fast and furious here as we're going along.  

The next one I have in my list is: Does the software only apply to new buildings? 

 

 The answer to that is no. If you have an existing home that you're modifying in 

such a way or putting an addition on, for example, and the local Building 

Department has told you that you're going to have to show energy code 

compliance, then you can use the software to help you do that.  That can be a 

little tricky in some circumstances, so again look at the software Help for more 

information. 

 

 Another question came in and they noted that Preferences was not an option 

when they looked at their Edit menu on the desktop version that they had 

installed. 

 

 The reason for that was that was a very old version of the software.  Our current 

version of REScheck available on energycodes.gov is 4.2.1.  So I would highly 

recommend that if you have a version older than that and you want to keep using 

the desktop version, that you go download the latest and greatest.  Preferences 

has only been a feature I think for the last two or three releases.   

 

 Can you enter both continuous and cavity insulation? 

 

 I think this question came in before Pam was doing the software demo and so 

hopefully she answered the question that: Yes, you can but only when it truly 

applies.  If you have questions on that, feel free to send us a more specific 
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question to techsupport@becp.pnl.gov, and we'll put up that email address again 

before we sign off today. 

 

 The next one I have is: Can this software be used for commercial buildings?  

 

 Well that's also a little tricky because it can be used for multifamily buildings. In 

some jurisdictions, multifamily buildings are considered commercial buildings 

depending on how many floors they have, et cetera.  We actually have a 

companion project to REScheck that's called COMcheck, which is for your more 

average commercial buildings, and the webcast for that is on March 19th. 

 

 When will the 2009 IECC be included in REScheck? 

 

 We are working fast and furious on that. The software developers have looked 

through the 2009 IECC and have already started implementation.  We will get 

that out just as soon as possible, but the absolute due date for that is the end of 

September, but we're hoping that it can be completed in the summer.   

 

 Pam. 

 

Pam Cole: Okay.  Does the software qualify a home for Energy Star status? 

 

 No, it doesn't, but that doesn't mean that you can use REScheck as your starting 

point. Energy Star status and HERS rating are based more on a performance of 

that building which takes into air leakage and doing a blower door test and so 

forth that provides a rating, a number rating on that building so… But can it be 

your starting point to say, "Okay, I am 20% better than the 2006 IECC," and I'm 
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just throwing that number out there, "I'm looking at achieving at Energy Star 

status. I can achieve Energy Star status with that so I'm going to go look at what 

else do I need to do to make this building reach the Energy Star," and you can go 

out to energystar.gov to look at all of their applicable requirements and talk to 

your building official as well. 

 

 Next question:  What importance does the condition floor area have or what does 

condition floor area mean? 

 

 The conditioned floor area entry that's in the Project tab of the software is code-

driven. It's for the 2006 IECC and IRC. It will most likely be for the 2009 IECC.  

This feature had to be put in there because if you had a building and you were 

showing compliance via it was passing by performance based on the mechanical 

equipment efficiency, which is very limited performance. It's based on one zone 

and that is why without doing that performance analysis, we couldn't do it unless 

we knew the total conditioned floor area of the building.  Can't run that 

calculation; we'd have to know it.  So if you have a huge house, three stories, we 

got to know what the conditioned floor area is before we can run that calculation 

in the back end. That is why it's there. 

 

 Next question:  If you have a ranch, first floor of conditioned space, is the floor 

over the unconditioned basement considered the conditioned floor area that is 

entered into the Project tab? 

 

 If you have an unconditioned basement, you're not calculating the basement floor 

as part of your total conditioned floor area. It is that floor above the unconditioned 

basement that you'd start calculating. That would be your conditioned floor area. 
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If you had a floor above that that was conditioned, then you add up both those 

floors. That's the total conditioned floor area, not the basement floor. 

 

 Another question:  Can the total BTU loss, BTU loss, be added to the standard 

program as is shown in the Wisconsin version? 

 

 A lot of you probably don't know this but Wisconsin is a state-specific code option 

within the software.  We do receive requests. A state energy office can request if 

they have adopted a code that's very state-specific, they have several 

amendments and they've adopted their own state energy code, they can request 

from DOE and look at the feasibility of having that code as a code option within 

these tools, and it just happens to be that Wisconsin's code has been in 

REScheck for many, many, many years. One thing, the only one that has an 

option to show loads and BTU loss is Wisconsin's version.  We do not have that 

available for any of the other codes and therefore you cannot show that. 

 

 Next question: When calculating a cathedral ceiling area, do you use the 

horizontal distance or the actual length of the ceiling slope? 

 

 Cathedral, you're going to use your calculations for the slope because you're 

doing full insulation into a cathedral, right. Where is it typically placed?  It's 

placed up in the roof deck area.  So with that one, you're again looking at: Where 

am I placing my insulation? If it's up against the roof deck, then you're calculating 

the slope of the roof and that's what you're using for your square footage. 
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 Next question: In our climate, we use both cavity and continuous, an example, a 

basement with exterior R-5 board insulation and interior two-by-four furred out 

with R-13 insulation.  What cell should I put this into? 

 

 Well, if you're doing exterior and interior, you're going to put R-13 under the 

Cavity Continuous column and you're going to put the R-5 under the Continuous 

Insulation column. Now here's something tricky, if you're not doing full height 

insulation for both those values, that's going to be a problem because the 

software dependent upon that one value that says "Depth of Insulation" is going 

to calculate both those values the same depth.  So if you have different depths, 

then maybe you're having to break out that basement wall component system, or 

you're having to calculate your basement wall as Other.  So with that, I will say 

that calculating a basement wall as other is a lot harder than doing it as above 

grade wall.  If you, whoever asked this question, has more - - wants more 

information, then we can do something like that through Technical Support 

offline.   

 

 Rose, you have any more questions? 

 

Rosemarie Bartlett: I do have more.  The next one I have is: The Tools menu is not present in the 

MAC version. Are the tools functions available elsewhere in the software? 

 

 The only thing that's actually in the Tools menu is AreaCalc and AreaCalc is only 

available in the Windows version of the desktop software.  So, no, AreaCalc is 

not available in the MAC version.   

 

 All right, how do you apply energy modeling to REScheck? 
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 REScheck is not an energy modeling tool. REScheck is an energy code 

compliance tool, so they don't correlate. They have different purposes. So if you 

are actually doing energy modeling, then you'll have to use a different tool.  

REScheck's not going to be able to help you out. 

 

 I have a question about this webcast as to whether or not it will be available for 

future viewing. 

 

 Yes, it will. Within the next two weeks on energycodes.gov under Recorded 

Webcasts there will be a video, an online video of this broadcast that can be 

viewed.   

 

 I also had a question about if there are any advantages to using the Web-based 

versus the desktop. 

 

 Well, I don't know if I'd say advantages. There are differences, so I guess it 

depends on what you're looking at.  Of course files that you create in the Web-

based tool, REScheck-Web, are on our server and so there available to you 

wherever you're at with an Internet connection, but of course you can also 

exchange files with the Web-based tool and the desktop.  So that's not 

necessarily an advantage but it could be.  The other thing, sometimes people use 

REScheck-Web so they have easy access to counties.  

 

 Another question came in asking whether the desktop tool can be changed to 

show counties instead of cities. 
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 It can be, and there is information in the software Help about how you can do 

that.  We purposely make it a little difficult, but it can be done.  But the easiest 

way to rectify that is to use REScheck-Web which always has cities and counties 

available to you.   

 

 Also one other advantage I suppose to the Web-based tool is if you're on a MAC 

and for whatever reason you have trouble using our MAC version, then you can 

use the REScheck-Web version. 

 

 All right, I think we have time maybe for a couple more questions, and there have 

been several that have come in as we've been answering questions so far, so I 

want to just reiterate that we will get back to you via email for those that didn't get 

answered. 

 

 Pam, you've got one more you want to do? 

 

Pam Cole: Yeah, I have one more.  With the new Adobe versions and Windows 

applications, Windows Vista, this has become a more popular question with our 

software.  We have a How-to Download REScheck right on the Download page if 

you are a Windows Vista user, and you actually need to download the application 

outside of its default where it would put into default files which is under your 

Program Files of your desktop.  With that, even with doing it that way, you still 

might have an issue if you have a higher version of Adobe on your computer.  

This is a Microsoft issue that we're trying to resolve, but here's some 

workarounds for you.  First one is what you'll find that if you go to the file 

View/Print Report, it won't come up, and you'll sit there and you'll go, "Well where 

is it?"  The thing to force it to show your report is save the data file, then go to the 
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File and save the report.  It's going to save it as a PDF.  Close REScheck down, 

go open your Adobe application.  What it's doing is that the Windows is not 

defaulting the Adobe program as your default for opening PDFs. It's not finding it, 

so you go force it to open it. So you go into Adobe, then go File Open, and open 

that PDF and then view it and print it.  That's a quick workaround if you have that 

issue. The other one is definitely if you're a Vista user, download the application 

on the little How-to that we have on the Download pages.   

 

 I think that's the last question that we have time for.  Any other questions, we will 

answer via email; and if you have additional questions that you can think of after 

this webcast, you can use our Help Form out on energycodes.gov and the Tech 

Support email that's shown up on the screen, techsupport@becp.pnl.gov.  The 

Help Form is probably a quick way. Go out to energy codes and also go out to 

our Resource Center.  A lot of information on our Frequently Asked Questions 

are in there.  You can search on just about anything and it has just an abundance 

of information - graphics, materials, sketches, you name it, so that might be 

another resource if you want to get something quickly as well.   

 

 Again, Rose. 

 

Rosemarie Bartlett: All right, thanks, Pam . Well we'd like to thank all of you for participating in 

today's webcast brought to you by the U.S. Department of Energy's Building 

Energy Codes Program.  You may all disconnect.   

 

Please Note: * Proper names/organizations spelling not verified.  
 [sic]  Verbatim, might need confirmation.  
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